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2.0 Disclaimer 
 

Ducks Unlimited, Inc. makes no representation or warranty of any kind regarding this material, data and information, 
including, but not limited to, the accuracy of the material, data and information or its suitability for any purpose. All use 
of the material, data and information is at the user’s sole risk. By using any of this material, data and information, the 
user agrees that Ducks Unlimited, Inc. is not responsible for their use of the material, data and information or the results 
thereof. 

 
For additional information about the project, reports, or maps, please contact: Ducks Unlimited, Inc., Great 
Lakes/Atlantic Regional Office, 1220 Eisenhower Place, Ann Arbor, MI 48108, (734)-623-2000. 
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3.0 Introduction 

3.1 Project overview 
The Minnesota Department of Natural Resources (MDNR) has taken the lead in coordinating a multi-agency effort to 
update and enhance the National Wetland Inventory (NWI) for Minnesota. Wetland inventories are an essential tool for 
effective wetland management, protection, and restoration. Such inventories provide baseline information for assessing 
the effectiveness of wetland policies and management actions. These data are used at all levels of government, as well 
as by private industry and non-profit organizations for wetland regulation and management, land use and conservation 
planning, environmental impact assessment, and natural resource inventories. The NWI is the only spatially 
comprehensive wetland inventory for Minnesota. Yet, there are issues with the original NWI data for Minnesota. First 
and foremost, the data are about 25 to 30 years out of date. Second, various limitations in the original technology, 
methodology, and source data resulted in an under representation of very small wetlands, drier-end wetlands, and 
forested wetlands. 

3.2 Project area 
The project area consists of 13 counties in east-central Minnesota including: Anoka, Carver, Chisago, Dakota, Goodhue, 
Hennepin, Isanti, Ramsey, Rice, Scott, Sherburne, Washington, and Wright Counties (Fig. 1). This area is 6,328 square 
miles, but the updated wetland inventory included complete coverage for all USGS quarter quadrangles that intersect 
any of these counties (about 7,150 square mile). 

 
Figure 1:  Project area - counties and quarter quadrangles covered 
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  3.3 Project organization 
Ducks Unlimited (DU) and the Minnesota Department of Natural Resource’s Resource Assessment Office (RA) partnered 
to perform the NWI update for the east-central project area.  DU had primary responsibility for developing the final 
updated NWI and RA had primary responsibility for the LiDAR and DEM processing as well as assisting with the field data 
collection. 
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4.0 Data 

4.1 Projection 
The NWI update for the east-central project area in Minnesota used the UTM projection, Zone 15N and the NAD83 
datum.  All data layers used this spatial reference.  The final products were also projected to Albers Equal Area Conic 
Projection, NAD83 to conform to the spatial reference set by the U.S. Fish and Wildlife for NWI data. 

4.2 Primary data layers 
The primary data layers for this project were the layers used in creating the segmentation and wetlands probability layer 
and/or the photo interpretation process. 

4.2.1 Spring Aerial Photos 
The primary image data set for the NWI update was the 2010/11 4-band, digital ortho quarter quads, spring leaf-off 
aerial imagery (http://www.mngeo.state.mn.us/chouse/airphoto/ecmn10.html) (Fig. 2).  Eleven of the thirteen counties 
were flown in 2010, with Rice and Goodhue flown in 2011.  Four counties (Wright, Sherburne, Isanti, and Chisago) were 
flown with a spatial resolution of 50 cm.  Seven counties (Carver, Scott, Dakota, Hennepin, Ramsey, Anoka, Rice, 
Goodhue and Washington) were flown with a spatial resolution of 30 cm. 

 

 
  0.5 meter, 4-band, spring imagery    0.3 meter, 4-band, spring imagery 
 

Figure 2. The spring aerial imagery for the east-central project area. 
 
 
 

http://www.mngeo.state.mn.us/chouse/airphoto/ecmn10.html�
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4.2.2 Summer Aerial Photos 
State-wide summer aerial photos have been flown by the Farm Service Agency (FSA) National Agriculture Imagery 
Program (NAIP) in 2008, 2009, and 2010.  The 2008 imagery is 4-band, ortho-rectified imagery, while the 2009 and 2010 
imagery is natural color (3-band), ortho-rectified imagery. (http://www.mngeo.state.mn.us/chouse/airphoto/fsa.html) 
 

4.2.3 LiDAR data 
LiDAR (Light Detection and Ranging) is an active remote sensing technology that operates on the power of laser light to 
detect and measure surface features on the earth. This data is particularly valuable for representing the topographical 
variation across a landscape. In Minnesota, LiDAR data is available for many areas of the state at a spatial resolution of 3 
meters. Specifically in the East-Central study area, the LiDAR data currently available was collected in eight counties 
(Chisago – 2007, Scott – 2003, Dakota – 2005-2006, Hennepin – 2008, Ramsey – 2008, Washington – 2008, Carver – 
2005, and McLeod – 2007)(Fig. 3).  
 

 
Figure 3. The LiDAR and NED coverage for the east-central project area. 

 

4.2.4 Digital Elevation Model (DEM) 
A Digital Elevation Model is a type of raster layer that represents the landscape in three dimensions, providing the x,y, 
and z characteristics at regular intervals. Each cell of the raster has a value corresponding to the surface elevation at that 
point on the landscape. DEMs in this analysis allow for systematic analysis of the relationships between elevation and 
other landscape characteristics. In the East-Central study area, the DEMs were derived from two different datasets. 
Since LiDAR (3 meter) is not available for the entire study area at the time of the analysis, the National Elevation Dataset 
(10 meter) was used to supplement (Fig. 3). 

http://www.mngeo.state.mn.us/chouse/airphoto/fsa.html�
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4.2.5 Palsar RADAR data 
 
PALSAR L-band radar data was acquired through a data grant from the Alaska Satellite Facility (ASF) DAAC and AADN 
data pool.  The data grant program is collaboration between ASF and NASA that offers free access to PALSAR upon 
approval of proposal.  Thirteen single date scenes were acquired to cover the east-central Minnesota project area 
through the data grant program.  The scenes available were a combination of single and dual polarization during spring 
and mostly leaf-off seasonal window (Table 1 and Fig. 4).  

 
Table 1. The Palsar L-band RADAR scenes acquired for the east-central project area. 

Palsar Scene ID Path Number Frame Number Beam Mode Start Time 
ALPSRP124590870 165 870 FBD MAY-27-2008 04:31:35 
ALPSRP124590880 165 880 FBD MAR-27-2008 
ALPSRP122840890 167 890 FBD MAY-15-2008 04:36:21 
ALPSRP229470900 164 900 FBD MAY-16-2010 04:33:54 
ALPSRP229470890 164 890 FBD MAY-16-2010 04:33:45 
ALPSRP229470880 164 880 FBD MAY-16-2010 04:33:37 
ALPSRP229470870 164 870 FBD MAY-16-2010 04:33:29 
ALPSRP225240900 165 900 FBS APR-17-2010 04:36:18 
ALPSRP225240890 165 890 FBS APR-17-2010 04:36:10 
ALPSRP221010900 166 900 FBS MAR-19-2010 04:38:41 
ALPSRP221010890 166 890 FBS MAR-19-2010 04:38:33 
ALPSRP221010880 166 880 FBS MAR-19-2010 04:38:25 
ALPSRP221010870 166 870 FBS MAR-19-2010 04:38:17 

 

 
Figure 4. The Palsar L-band RADAR imagery for the east-central project area. 
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4.2.6 SSURGO Soils Data 
The Natural Resources Conservation Service (NRCS) produces soils maps in GIS format (Soil Survey Geographic 
(SSURGO)) from the original soil survey maps.  These maps can be very useful in identifying wetlands using various 
combinations of attributes contained within the SSURGO database.   The SSURGO database was available for the entire 
east-central Minnesota project area. http://soils.usda.gov/survey/geography/ssurgo/description.html 
 

 4.3 Ancillary data layers 
The ancillary data layers were used for creating the training data for the wetlands probability layer and for assisting with 
the photo interpretation.  A separate training data set was collected by the University of Minnesota for the final 
wetlands assessment.  

4.3.1 Metropolitan Mosquito Control District wetland layer 
The Metropolitan Mosquito Control District monitors and controls mosquito, tick, and other potential disease-causing 
insect populations across the metropolitan St. Paul and Minneapolis area. MMCD maintains detailed data of the 
location, size, and type of potential breeding grounds across an approximately 2,800 mi2 area. Breeding area types are 
based on wetness and vegetation type and are defined in Table 2 (adapted from MMCD metadata).  Nearly all of the 
sites are visited by MMCD field staff. MMCD data is available in polygon format.  (http://www.mmcd.org/) 
 

Table 2: Wetland types as documented by MMCD 

1. Temporary water; usually well-drained during much of 
the growing season 

1.1 Open field, usually grass 

1.2 Woodland pool or floodplain forest; could produce 
both spring and summer mosquitos 

1.3 Woodland pool, only spring mosquitoes produced 

2. Temporary water; typically dries out at some time 
during the year but may stay waterlogged. 

2.1 - Reed canary grass, predominantly. No cattail 

2.2 - Sedge meadow, predominantly. No cattail 

2.3 - Assorted aquatic plants (not cattail, not 
predominantly reed canary grass or sedge) 

3. Temporary water; wet or waterlogged most of year in 
wet years, may dry out in midsummer or dry years 

3.1 - Majority reed canary grass and sedge, remainder 
mostly cattail 

3.2 - Majority cattail, remainder reed canary grass and 
sedge 

4. Permanent water, usually ca. 3 ft deep 

4.1 - Vegetative band mostly canary grass and sedges; 
perm. open water area less than area covered by 
vegetation 

4.2 - Vegetative band mostly cattails or broadleaf plants; 
open water area less than area covered by vegetation 

4.3 - Majority of site is open water; narrow band of cattail, 
grass, sedge or other vegetation 

4.4 - Majority open water; steep banks, very little 
emergent vegetation (ex: golf hazards, "duck ponds") 

http://soils.usda.gov/survey/geography/ssurgo/description.html�
http://www.mmcd.org/�
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5. Permanent water ca. 10 ft. deep, may contain game fish 

5.1 - Most vegetation grass and sedge, some cattail; open 
water area less than area covered by vegetation 

5.2 - Mostly cattails and/or broadleafs, some grass or 
sedge; open water area less than area covered by 
vegetation 

5.3 - Majority of site is open water; narrow bands of 
cattail, grass, sedge or other vegetation 

5.4 - Shallow pond or reservoir that does not contain game 
fish (including panfish) 

6. Shrub swamp; usually waterlogged during growing 
season. 

6.0 - (only type used) 

7. Wooded swamp 7.0 - Usually tamarack 

8. Bog 
8.1 - Poorly drained, wet spongy ground rich in plant 
residue 

8.2 - Floating mat 

4.3.2 Native Plant Communities 
The Minnesota County Biological Survey collects information on high-quality, native plant communities.  The Minnesota 
County Biological Survey locates higher quality native plant communities using aerial photo interpretation followed by 
field survey of selected sites. These native plant communities can be downloads in GIS format from the Minnesota DNR 
data deli (http://deli.dnr.state.mn.us/metadata.html?id=L250000040201).   
 

4.3.3 Minnesota Wetland Monitoring Survey 
The MN DNR Resource Assessment monitors wetlands throughout the state using 5,000 1-mi2 plots as part of a broader 
wetland monitoring program.  The classification used in the plots is shown in Table 3.  

Table 3: Name, codes, and definitions for the wetland and non-wetland classifications 

Code Habitat Name General Description 

Deepwater class:  delineate to 1-acre minimum * 

DW Deepwater Lakes, reservoirs, rivers, streams 

Wetland classes:  delineate to 1-acre minimum * 

FO Forested wetland Forested swamp 

SS Shrub swamp Woody shrub or small tree marshland 

EM Emergent wetlands Marshes, wet meadows, and bogs 

AB Aquatic bed Wetlands with floating and submerged aquatics 

UB Unconsolidated bottom Open water wetland, shore beaches and bars 

CW Cultivated wetland Wetlands in agricultural fields 

Wetland modifier 

m Manmade DW, UB, AB or EM of artificial origin 

   

Upland habitats:  delineate to 5-acre minimum 

U Urban Cities, incorporated developments 

http://deli.dnr.state.mn.us/metadata.html?id=L250000040201�
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R Rural development Non-urban developed areas, infrastructure 

A Agricultural Cultivated lands and managed upland pasture 

S Silvicultural Forest stands of planted trees, plantations – including hybrid poplar 

N Natural Unplanted forest, grassland, Shrubland, old fields 

O Other All uplands not otherwise classed 

Emergent Wetlands Subclasses 

IN Inundated 
Usually larger than 3 acres and are frequently associated with other fringing 
wetland classes or water regimes in the transition to upland habitats 

SE Seasonal 
Typical in glaciated depressional basins or are frequently associated with 
inundated emergent wetlands or stream systems. 

SA Saturated 
Typical water regime in lowland flats with little topographic gradient and 
also wetlands associated with ground water seepage faces located on 
slopes. 

TE Temporary 
Typical in small (usually less than 3 acres) wetlands in glaciated regions, 
particularly agricultural regions, though small temporary basins do occur in 
upland forested regions 

 

4.3.4 U.S. Fish and Wildlife Service National Wetland Inventory 
The U.S. Fish and Wildlife Service’s National Wetland Inventory (NWI) data is also available for Minnesota, but is about 
25 to 30 years old.  The data can be downloaded from the NWI web site: http://www.fws.gov/wetlands/ .  

http://www.fws.gov/wetlands/�
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5.0 Cowardin Classification System guidance for Minnesota 
 

The primary classification system used for the National Wetland Inventory (NWI) was described by Cowardin et al. 
(1979). All wetland classification definitions for the 2010 update of the Minnesota NWI follows Cowardin et al. (1979) 
and Dahl et al. (2009) unless otherwise noted below.  The following section describes the valid codes and descriptions of 
the Cowardin classification system as applied to the 2010 Minnesota NWI update. A full list of valid codes is provided in 
Table 4.   For examples of the NWI classes and how they were interpreted, please see the Photo Interpretation Guide for 
the 2010 Minnesota NWI Update (Ducks Unlimited 2012). 

Table 4: Valid codes for NWI update of Minnesota 

System Subsystem Class Subclass Water Regime 
Special 
Modifier 

L L1 UB   H, K h, x 
            
L  L2 UB   F, H, K b, d, h, x 
    AB   F, H, K b, d, h, x 
    EM 2 F, H, K b, d, h, x 
    US   A, C, K b, d, h, x 
    RS   A, C, K b, d, h, x 
    RB   F, H, K b, d, h, x 
            
P    UB   F, H, K b, d, h, x 
    AB   F, H, K b, d, h, x 
    EM 1 A, B, C, F, K b, d, f, h, x, q 
    EM 2 C, F, H, K b, d, h, x,  
    FO 1, 2, 4 A, B, C, F, K b, d, h, x, q 
    SS 1, 2, 3, 4 A, B, C, F, K b, d, h, x, q 
    US   A, C, K b, d, h, x 
    RB   F, H, K b, d, h, x 
    ML   B d, q 
            
R R2 UB   H h, x 
    AB   H h, x 
    US   A, C h, x 
    EM 2 F, H h, x 
    RS   A, C h, x 
    RB   H h, x 
          h, x 
R R3 UB   F, H h, x 
    US   A, C h, x 
    RS   A, C h, x 
    RB   F, H h, x 
            
R R4 SB   A, C h, x 
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5.1 Cowardin classes 
The Cowardin classification system is a hierarchical system developed to standardize the classification of wetlands and 
deepwater habitats of the United States. At the highest level are five systems: marine, estuarine, riverine, lacustrine, 
and palustrine. Only three of these systems are relevant to the inland wetlands found in Minnesota: riverine, lacustrine, 
and palustrine. Santos and Gauster (1993) included a list of valid Cowardin wetland types for Minnesota in their regional 
user’s guide to the National Wetland Inventory Maps. 

Within the riverine and lacustrine systems, there are subsystems. Minnesota has lower perennial rivers, upper perennial 
rivers, and intermittent streams for riverine subsystems. There are no tidal riverine systems. There are also two 
lacustrine subsystems, limnetic and littoral. The palustrine system has no subsystems. Within each of these systems and 
subsystems there are several classes that are defined either on the dominant vegetation (e.g. scrub-shrub and forested) 
or the dominant substrate (e.g. unconsolidated bottom). Additional details of the classification system including the 
definition of each system, subsystem, class, and subclass can be found in Cowardin et al. (1979) and Dahl et al. (2009). 

Valid classes for the remaining systems and subsystems were derived from Cowardin et al. (1979). These wetland classes 
are listed in Table 5.  

General guidance for wetland classes:  

• All wetland polygons will be classified to the Cowardin class level.  

• Estuarine and marine systems and the tidal riverine system will not be used. 

• Use of subclasses will be limited to emergent, scrub-shrub, and forested wetlands and must be identified for 
these classes (section 5.2). 

• Only the systems, subsystems, and classes listed in Table 2 should be used for the NWI update. 

• Mixed classes are allowed as specified by Dahl et al. (2009), but should be minimized (section 5.1.1). 
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Table 5: Valid classes for NWI update of Minnesota 

 

5.1.1 Mixed classes 
Mixed classes should be avoided if possible (areas of homogenous classes should be delineated as separate polygons).  
In cases where the classes are interspersed without clear spatial definition of the classes, the mixed classes should be 
limited to: FO/SS, FO/EM, SS/EM, UB/SS, and AB/SS with no reciprocals. 

System Subsystem Class Code 

Lacustrine 

Limnetic Unconsolidated Bottom L1UB 

Littoral 

Rock Bottom L2RB 
Unconsolidated Bottom L2UB 
Aquatic Bed L2AB 
Rocky Shore L2RS 
Unconsolidated Shore L2US 
Emergent L2EM 

Palustrine  

Rock Bottom PRB 
Unconsolidated Bottom PUB 
Aquatic Bed PAB 
Unconsolidated Shore PUS 
Moss-Lichen PML 
Emergent PEM 
Scrub-Shrub PSS 
Forested PFO 

Riverine 

Lower Perennial 

Rock Bottom R2RB 
Unconsolidated Bottom R2UB 
Aquatic Bed R2AB 
Rocky Shore R2RS 
Unconsolidated Shore R2US 
Emergent R2EM 

Upper Perennial 

Rock Bottom R3RB 
Unconsolidated Bottom R3UB 
Rocky Shore R3RS 
Unconsolidated Shore R3US 

Intermittent Streambed R4SB 
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5.2 Wetland subclass 
The historical application of the Cowardin subclasses in the Minnesota NWI is inconsistent with current guidance. Some 
historical subclasses such as subclass 5 for palustrine emergent wetlands were used in Minnesota, but have been 
abandoned in recent guidance or re-purposed (Dahl et al. 2009). In addition, many of the subclasses are difficult to 
reliably determine using remote sensing data. For this reason, the federal wetlands mapping standard (FGDC 2009) only 
requires subclasses for the emergent, scrub-shrub, and forested classes. 

General guidance for subclasses:   

• Subclasses will be only be used for scrub-shrub, forested, and emergent wetland classes and must be identified 
for these classes.  

• Whenever possible, the most specific subclass, such as broad-leaved deciduous (PFO1) should be used instead of 
the more generic subclasses, such as deciduous (PFO6).  

• There are no broad leaved evergreen tree species in Minnesota, so that subclass (PFO3) should not be used. 
However, there are broad-leaved evergreen shrub species (PSS3).  

• Based on discussions of the technical advisory committee, sub-class 5 (dead) for both scrub-shrub wetlands and 
forested wetlands should be avoided. Wetlands should be classified based on the dominant (>30% cover) living 
life form or substrate. 

• Valid subclasses for the Minnesota NWI are in Table 6. 

• Mixed subclasses on forested and scrub-shrub classes should be avoided if possible (section 5.2.1) 
 

Table 6: Subclasses for the NWI update of Minnesota 

Class Subclass 
Emergent 1-Persistent 

2-Nonpersistent 
Scrub-Shrub 1-Broad-leaved deciduous 

2-Needle-leaved deciduous 
3-Broad-leaved evergreen 
4-Needle-leaved evergreen 
6-Deciduous* 
7-Evergreen* 

Forested 1-Broad-leaved deciduous 
2-Needle-leaved deciduous 
4-Needle-leaved evergreen 
6-Deciduous* 
7-Evergreen* 

 * The more specific subclasses will be used whenever possible. 

5.2.1 Mixed subclasses 
Mixed subclasses on forested and scrub-shrub should be avoided if possible (areas of homogenous subclasses should be 
delineated as separate polygons).  In cases where the classes are interspersed without clear spatial definition of the 
subclasses, the mixed classes should be limited to: 1/2, 1/3, 1/4, 2/4 and 3/4 with no reciprocals.  
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5.3 Water regime modifier  
To fully describe wetlands and deepwater habitats, one must apply certain modifiers at the class level or lower. The 
water regime modifier describes the hydrologic characteristics of the wetland including the frequency and duration of 
inundated or saturated conditions. Because detailed hydrologic records are seldom available, the assignment of water 
regime modifiers relies on interpretation of water levels from images taken at various times as well as interpretation 
based on the plant communities. 

There are some differences in water regime definitions between various guidance documents (Cowardin et al. 1979; 
Santos and Gauster 1993; Dahl et al. 2009). The Minnesota NWI update will use the water regimes A, B, C, F, H, and K as 
defined by Dahl et al. (2009). There are no tidal or sub-tidal water regimes. The Minnesota NWI update will also not use 
the E water regime (seasonally flooded – saturated) due to its potential overlap with the C water regime.  The 
Intermittently Flooded (J) water regime is generally considered to only occur in the western United States. This water 
regime is also excluded from the Minnesota NWI update.  In addition, due to the difficulty in determining the difference 
between Intermittently Exposed (G) and Permanently Flooded (H) with limited temporal data, the G class will not be 
used. 

Given the limited temporal data (typically only one spring image and maybe just a few relatively recent summer images), 
it will be difficult to classify water regime on the basis of water observation alone. Instead, it will be important to make 
inferences based on plant community, landscape position, and other factors. Fortunately, Cowardin et al. (1979) 
simplifies this task somewhat by restricting the water regimes for each class to only a few possibilities. In addition, water 
regimes are further restricted somewhat by regional wetland characteristics. For example, Cowardin allows for forested 
wetlands to have all water regimes except sub-tidal regimes. However, Minnesota does not have any tree species that 
can tolerate permanent or semi-permanent flooding (like Cypress). This is confirmed by the statistics for water regimes 
in the original NWI for Minnesota.  

General guidance for water regime:  

• Water regime modifiers will be applied to all wetland polygons.  

• Only the A, B, C, F, H, and K water regimes as defined by Dahl et al. (2009) will be used in Minnesota.  

• The (E) water regime from Dahl et al. (2009) will not be used. Instead, it will be incorporated into the (C) water 
regime. 

• Due to the potential difficulty of reliably separating F, G, and H water regimes without long-term hydrologic 
records, the G water regime will not be used. Instead wetlands with more permanent water regimes will be 
classified as either semi-permanently flooded (F) or permanently flooded (H). 

• The (J) water regime will not be used. 

• Water regimes for each valid Cowardin class are listed in Table 7, with most-likely water regimes indicated by 
the abbreviation “ML”. 
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Table 7: Water regime modifiers for the NWI update of Minnesota 

 Water Regime 
Cowardin Class A B C F H K 
L1UB     ML P 
L2UB    P ML P 
L2AB    P ML P 
L2EM    P ML P 
L2US ML  P   P 
L2RS ML  P   P 
L2RB    P ML P 
PUB    P ML P 
PAB    P ML P 
PEM P P ML P P P 
PFO P ML ML P  P 
PSS P ML ML P  P 
PUS ML  P   P 
PRB    P ML P 
PML  ML     
R2UB     ML  
R2AB     ML  
R2US ML  P    
R2EM    ML P  
R2RS ML  P    
R2RB     ML  
R3UB    P ML  
R3US ML  P    
R3RS ML  P    
R3RB    P ML  
R4SB ML  P    

* The most-likely water regimes are indicated by “ML”. Possible, but not-likely, water regimes 
are indicated by “P”.

5.4 Special modifier  
Special modifiers were used extensively in the original NWI and will be used in the NWI update (Table 8). The most 
commonly used special modifier in the original NWI for Minnesota was the (d) modifier for partly drained or ditched. 
Many of Minnesota’s wetlands are partly drained or ditched and this characteristic is readily interpretable from most 
aerial imagery. The application of special modifiers for beaver impacts and excavated wetlands were also frequently 
used. As with the partly drained wetlands, these characteristics are readily identifiable from aerial photos. Diked and 
impounded wetlands can be photo-interpreted, but oftentimes ancillary data such as the impoundment structures GIS 
database from the DNR Division of Waters may be needed to identify these features. 

Little used modifiers include the modifiers for farmed, artificial substrate, and spoils. The farmed modifier was little used 
at least in part due to policy decisions not to map most farmed wetlands in the original NWI for Minnesota. The current 
policy is to map these farmed wetlands, where they exist. The typical farmed wetland in Minnesota is usually a 
depression that is wet in the spring and it shows signs of cultivation. It may be cropped during the summer, but crop 
stress is often evident.  Please see the Photo Interpretation Guide for the 2010 Minnesota NWI Update for examples of 
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identifying farmed wetlands. Based on discussions with the technical advisory committee, the spoils modifier (s) will not 
be used in the NWI update for Minnesota. In addition, the artificial modifier (r) will not be used in the NWI update for 
Minnesota.  Wastewater ponds will be coded as PUBKh. 

A new modifier is proposed specifically for the Minnesota NWI update. Wetlands that have peatland (bog/fen) 
signatures (typical vegetation may include Sphagnum, Leatherleaf, Sedges, Black Spruce, and Tamarack) should be 
assigned the (q) modifier. Peatlands are readily identifiable from color-infrared imagery (Hop et al. 2000). 

Guidance for special modifiers:   

• Special modifiers will be applied using the definitions provided by Dahl et al. (2009), except that the special 
modifier for spoils (s) and artifical (r) will not be used. 

• Farmed wetlands will be identified whenever possible using the guidance in the Photo Interpretation guide. 

• An additional special modifier will be added and applied to indicate peatlands (based on the presence of 
Sphagnum peat mat or other peatland indicators).  

• Do not use the r (artificial) special modifier.   

• Wastewater stabilization ponds will be coded PUBKh. 

 

Table 8: Valid special modifiers for the NWI update of Minnesota 

Special Modifiers 
Beaver (b)  
Partly drained/ditched (d) 
Farmed (f) 
Diked/impounded (h) 
Peatland (q)  
Excavated (x) 

 

5.5 Water chemistry modifier issues 
The water chemistry modifiers were virtually ignored in the original NWI for Minnesota. Only four polygons were 
associated with water chemistry modifiers. Certain peatlands identified with the special modifier (q) are likely to be 
acidic, but pH cannot be reliably determined from remote sensing data. Therefore, water chemistry modifiers will not be 
applied for the NWI update for Minnesota. 

 

5.6 Soil modifier issues 
The original NWI did make some use of the soils modifiers, but their use was inconsistent. The most reliable mapped 
information on soils in Minnesota is from the USDA Soil Survey Geographic (SSURGO) Data. Application of soil modifiers 
in the absence of additional field work would be no better than simply relying on SSURGO. Therefore, soil modifiers will 
also not be applied to the NWI update for Minnesota. 
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6.0 Training data 
The Random Forest™ classification process requires training data as input for the classification process.  The training 
data consists of point locations of known wetland and upland types.  Each location is classified according to the 
classification scheme list in section 5.  The initial training data for the east-central project area was aggregated from on-
the-ground field work and ancillary data.  In total, 3350 points were used in the initial training data set. The breakdown 
by system and subsystem is shown in Table 9, with a breakdown by full code in Table 10. 510 sites were visited during 
field work, 1967 were chosen from ancillary datasets, and an additional 873 were identified by DU staff from aerial 
imagery.  As each quarter quad is updated, additional training data will be merged with the initial training data to create 
a more robust training data set. 

 

Table 9: Breakdown of training points by system 

Classification Total 

Palustrine:     
  Forested 359 
  Scrub-Shrub 103 
  Emergent 1029 
  Aquatic Bed 311 
  Unconsolidated Bed 547 

Lacustrine: 
 

  
  Aquatic Bed 18 
  Unconsolidated Bed 39 

Riverine: 
 

  
  Unconsolidated Bed 22 

Upland:   796 
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Table 10: Breakdown of training points by full classification 

FULL_CODE FREQUENCY FULL_CODE FREQUENCY FULL_CODE FREQUENCY 
L1UBH 17 PEM1F 109 PSS1A 41 
L2ABG 5 PEM1Fd 4 PSS1B 15 
L2ABH 13 PEM1Fh 1 PSS1C 37 
L2UBH 21 PEM1Fx 9 PSS1Cd 4 
L2UBHx 1 PFO1/2B 2 PSS2Bq 2 

PAB/EM2F 2 PFO1/2Bd 1 PSS3Bq 4 
PABF 87 PFO1/EM1A 13 PUBF 60 
PABFx 61 PFO1/EM1B 4 PUBFh 2 
PABG 9 PFO1/EM1C 19 PUBFx 215 
PABGx 7 PFO1/SS1A 11 PUBG 9 
PABH 117 PFO1/SS1C 12 PUBGx 10 
PABHh 9 PFO1A 174 PUBH 104 
PABHx 21 PFO1Ad 12 PUBHh 25 
PEM1A 239 PFO1B 51 PUBHx 114 
PEM1Ad 44 PFO1Bq 1 PUBKh 8 
PEM1Af 51 PFO1C 91 R2UBH 22 
PEM1Ax 16 PFO1Cd 11 U - Ag 264 
PEM1B 42 PFO2B 5 U - FO1 86 
PEM1Bd 8 PFO2Bq 9 U - FO4 34 
PEM1Bq 7 PFO4A 1 U - Open 79 
PEM1Bx 5 PFO4B 1 U - Rec 25 
PEM1C 398 PSS1/EM1A 16 U - Res 84 
PEM1Cd 57 PSS1/EM1B 8 U - Road 62 
PEM1Cq 13 PSS1/EM1C 36 U - Urban 162 
PEM1Cx 26 PSS1/EM1Cd 5   

 

6.1 Field data collection  
Field training data for photo interpretation projects is extremely important in order to guide the interpretation.  The 
field training data for the east-central project area served three purposes: 1) provided experience for the staff members 
updating the Minnesota NWI in the local wetland identification and classification, 2) gathered images for use in a 
guidebook for wetland photo interpretation, and 3) collected training data for the creation of a potential wetlands layer 
using a Random Forest™ classification.   Within the project area, 12 quads with wetlands representative of those found 
in the project area were selected for field verification (Fig. 5).  These quads included urban, residential, and rural areas. 
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Figure 5: Location of quads within project area 

6.11 Field training data selection 
A frequency table was created of wetland types across the 12 field training quads. Wetlands were randomly flagged for 
field sampling in proportion to the frequency of that wetland class across all 12 quads, with the exception of rarely 
occurring wetland types, which were all flagged for field sampling. 

6.12 Field training database 
During the field data collection process, information on each site was simultaneously recorded on field data sheets and 
entered into the NWI photo file geodatabase. Direction of photo, wetland classification, collector’s name and 
organization, date, and additional comments were recorded for each site. Additionally, the photos will be attached to 
the point layer and kept in a separate SDE geodatabase.  
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6.13 Field data results 
During the four day period, 503 sites were visited. An additional seven were visited at an earlier date, for a total of 510 
sites (Fig.  6). All sites were entered into DU’s NWI geodatabase and will be used to assist in the classification process 
and photo interpretation of the NWI product. Metadata (information describing the dataset) was also created for the 
field training data geodatabase. The field training data geodatabase (points, attributes and site photos) were delivered 
to the MN DNR and U.S. Fish and Wildlife Service and to be archived with the official NWI data for future reference. 

 

 

Figure 6: Field sites visited for this project 
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 6.2 Additional Ancillary Data for Training Data 
Existing data sets as well as photo interpretation of upland classes were used to supplement the field data for the initial 
training data input into the random forest classification.  

 6.21 Metropolitan Mosquito Control District (MMCD) 
The MMCD polygon features were converted to point features by calculating the centroid of each polygon. The point 
data was clipped to the test quad boundaries, bringing the number of features down from over 57,000 to 6,562. These 
points informed the interpreter of the approximate wetness of each area, providing a more accurate assessment of the 
potential water regime for a site. The MMCD data was used to supplement areas within the 12 reference quads that 
were lacking training data.  The MMCD sites selected were classified according to NWI standards and were included in 
the final dataset of training points. There were 1,140 MMCD points included in the final training data.  

6.22 Native Plant Communities 
The Minnesota DNR provided data from the 2003 Minnesota County Biological Survey (MCBS) of native plant 
communities.  The polygon features were converted to point features by calculating the centroid of each polygon and 
clipped to the test quad boundaries.  The points were classified according to NWI standards and were included in the 
final dataset of training points, with 288 of these points included in the final reference data. 

6.23 Minnesota Wetland Monitoring Survey 
The MN DNR Resource Assessment provided shapefiles covering the 53 plots that intersected the test quads used for 
training data.  There were anywhere from 2 to 366 features per plot. The centroid of each polygon was calculated; from 
the resulting point file, representative points were classified by NWI type and included in the final reference data file. 
539 points (of 2,273 within the test quads) from the wetland monitoring survey plots were included in the final file. 

 6.3 Additional training points 
In addition to the training points from field data and Minnesota DNR data, Ducks Unlimited staff used aerial imagery to 
identify an additional 873 training points. The majority of these points were chosen for distinguishing different upland 
land types: agriculture, upland forest (deciduous and coniferous), open upland, recreation, residential, roads, and urban 
land cover. The rest of the points were chosen to provide more examples for less common wetland classes. 

The final set of point features used as training data is shown in Figure 7.  
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Figure 7: Training points used as reference data 
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7.0 Data processing 
 

7.1 Spring Aerial Photos 
The Minnesota NWI update project conducted by Ducks Unlimited and the MN DNR Resource Assessment group utilized 
two resolutions of imagery (30cm and 50cm pixel resolution) for image interpretation and segmentation for the purpose 
of wetland delineation and labeling for incorporation into the updated NWI database.  After considerable difficulty in 
identifying a set of image segmentation parameters that would produce comparable results in both image resolutions, a 
solution was proposed which entailed resampling (coarsening) the 30cm resolution data to the same spatial resolution 
as the 50cm data available for the majority of the project area. The 30cm imagery was retained and used for photo-
interpretation tasks but for the purposes of automated image analysis the resampled data allowed for a single unified 
set of processing algorithms to be applied across the entire project area.  

In order to ensure the resampling step would not compromise the quality of the final database a small evaluation was 
developed to test alternative resampling methods with respect to the image segmentation process. The resampling 
evaluation yielded visual and segmentation results similar to the imagery acquired and delivered at 50cm resolution 
(50cm base). Therefore, the 30cm data was resampled to 50cm for the purposes of image segmentation for this project. 

 

Figure 8. Segmentation based on data resampled to 50cm resolution displayed over the original unaltered 30cm 
imagery at a scale of 1:1000. 
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7.2 LiDAR/DEM processing 
Several topographic metrics or indices were derived from the LiDAR/DEM data. These derived metrics and indices 
potentially provide a greater ability to discriminate wetland from upland than the DEMs alone.  These derivatives are 
described in the following sections.  Since the LiDAR DEMs have a resolution of 3m and the NED DEMs have a resolution 
of 10m, they were processed separately. 

7.2.1 Curvature 
The curvature of a surface at any given point helps to explain the speed and direction of the flow of water across the 
area in question.  Each cell’s curvature value is the second derivative of the surface based on its eight neighboring cells. 
This process can be completed using the Spatial Analyst extension in ArcGIS.  A positive curvature value indicates the 
surface is upwardly convex at that point, while a negative value indicates the surface is upwardly concave 
(http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=curvature) 

7.2.2 Planform Curvature 
Planform curvature measures the curvature of a surface perpendicular to the direction of the maximum slope. A 
negative value indicates the surface is sidewardly concave, while a positive value indicates the surface is sidewardly 
convex.  The curvature tool has an optional planform curvature output. 
(http://blogs.esri.com/Support/blogs/mappingcenter/archive/2010/10/26/Understanding-Curvature-Rasters.aspx) 

7.2.3 Profile Curvature 
Profile curvature measures the curvature of a surface parallel to the direction of maximum slope. A negative value 
indicates the surface is upwardly convex, while a positive value indicates the surface us upwardly concave.  The 
curvature tool has an optional profile curvature output. 
(http://blogs.esri.com/Support/blogs/mappingcenter/archive/2010/10/26/Understanding-Curvature-Rasters.aspx) 

7.2.4 Topographic Position Index (TPI) 
TPI values provide a simple and powerful means to classify the landscape into morphological classes (Jenness 2005 and 
Tagil and Jenness 2008).  TPI is a simplification of the Landscape Position Index described by Fels and Zobel (1995) and 
developed by Weiss (2001). 

TPI for each cell is calculated by subtracting the mean elevation of its neighborhood from its own elevation value.  A 
positive value indicates the pixel is higher than its neighbors, while a negative value indicates it is lower. This simple 
classification is a useful means of mapping topographic depressions. Groups of pixels with negative TPI scores represent 
such depressions, and are possible wetland locations. 

A Digital Elevation Model (DEM) is the only data required to calculate TPI.  An ArcGIS Model Builder was used to create 
the TPI (Fig. 9).  Selecting appropriate neighborhood settings is an important part of the process. Selecting too small of a 
neighborhood will result in very fine resolution which is not adequate for detecting topographic depressions over large 
areas.  Selecting too large of a neighborhood will result in depressions which may encompass upland areas as well. For 
the east-central project area, a circular neighborhood with radius of 15 and 20 cells (45 and 60 meter for the LiDAR 
DEMs) were selected.  

http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=curvature�
http://blogs.esri.com/Support/blogs/mappingcenter/archive/2010/10/26/Understanding-Curvature-Rasters.aspx�
http://blogs.esri.com/Support/blogs/mappingcenter/archive/2010/10/26/Understanding-Curvature-Rasters.aspx�
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Figure 9.  The ArcGIS Model Builder for calculating the TPI. 

 

7.2.5 CTI 
The Compound Topographic Index (CTI) is a function of both the slope and the upstream contributing area.  CTI can be 
calculated as:  

CTI = ln (As / (tan(β)),  

where As =  contributing area and β is the slope expressed in radians. Slope and flow direction were calculated using the 
TauDEM tool (Tarboton 2003). Flow direction was calculated using the D-Infinity (D-inf)algorithm. Flow direction was 
then used to derive the contributing drainage area, also using TauDEM. The slope grid and contributing area were then 
plugged in the equation for CTI.  

Prior to calculating the CTI, 3m LiDAR DEMs were clipped to the quarter-quad boundaries. Topographic depressions 
(sinks) were then removed to generate a sinkless DEM.  A python script was written to batch process the CTI.  Testing 
was conducted to determine if it was necessary to modify the DEM to account for subsurface drainage connections such 
as road culverts in order to use the CTI for wetland mapping. The results of this testing indicate that the accuracy of the 
RandomForest ™ model were not improved by burning-in these subsurface features. Given the level of effort and 
expense involved in making these modifications, it was determined that future processing of CTI would not include these 
subsurface features. 

 

7.3 Palsar  
ASF MapReady Remote Sensing Tool Kit (MapReady, 2011) was used for terrain correction, geocoding, and exporting to 
geo-tiff file format.  After terrain correction was applied the pre-processed PALSAR scenes still contained some 
distortion within in the project area so further geo-rectification was performed in ArcGIS using selected control points 
from the aerial imagery.  The RADAR processing extension in Opticks (Opticks, 2011) was used to reduce speckle in the 
PALSAR data.   

A 10 class maximum-likelihood clustering routine implemented in ERDAS Imagine software (ERDAS, 2008) was used to 
produce an unsupervised classification of the PALSAR data. Clusters visually identified as being associated with “wet 
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forest” were assigned that classification value.  Analysts noted some confusion between wet deciduous forest and pine 
plantations, some agricultural areas and urban areas. This confusion was remedied during subsequent image 
segmentation and classification steps. The final product from the PALSAR analysis was a binary 1/0 raster layer 
representing likely wet areas within deciduous forests. This layer was integrated into the overall wetland mapping 
process by incorporating it into the image segmentation process and as an additional ancillary data layer available to the 
photo-interpretation team. 

 

7.4 SSURGO 
Two soil map products were created as inputs in the NWI Update for Minnesota; (1) an oridinal map based on the 
predominant soil water regime, and (2) a continuous variable map based on the sum of component percentage that 
meets a specified hydric soil criterion. Both of these products rely on soils data from the NRCS (i.e. SSURGO). Soil 
variables are extracted from the NRCS database for the project area. The variables included in the analysis were the 
variables most likely to be related to wetland water regime (e.g. drainage class, flood frequency for April, pond 
frequency for April, and pond frequency for August). 

Both data products can be created using the same MS Access query results from three basic queries.  

Query 1 

SELECT mapunit.mukey, mapunit.musym, mapunit.muname, component.compname, component.comppct_r, 
component.drainagecl, component.geomdesc, component.cokey 

FROM mapunit INNER JOIN component ON mapunit.[mukey] = component.[mukey]; 

Query 2 

SELECT comonth.[cokey], comonth.[month], comonth.[flodfreqcl], comonth.[pondfreqcl] 

FROM comonth 

WHERE (((comonth.[month])="April")); 

Query 3 

SELECT comonth.[cokey], comonth.[month], comonth.[pondfreqcl] 

FROM comonth 

WHERE (((comonth.[month])="August")); 

The first query is the related to the second and third queries using the [cokey] field toinclude all records from  first query 
and only those records from the second and third query where the join fields are equal. 

The complete query report is created by selecting all fields from first query and append the fields from the  second and 
third queries.  The result is exported to MS Excel. 

Water Regime Product  
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The drainage class, April flood frequency, April pond frequency, and August pond frequency fields are contatenated and 
the results sorted on the concatenated field. The soil component data are then classified according the criteria in Table 
11. 

The resulting table includes water regime classes for all soil components. Map units may contain more than one 
component; therefore, the data must be summarized to the map unit level. This is done by concatenating the map unit 
symbol field with the water regime class. A pivot table is created to summarize component percentage (sum of comppct) 
by the new concatenated field of MUSYM-WR. For any map units that have more than one water regime, the 
predominant water regime is identified. Duplicate MUSYM values were eliminated so that the final table only includes 
distinct values.   

For each map unit, select the component with the largest percentage contribution (max[comppct_r]). Join the tabular 
data from the MapUnit_WR worksheet to the SSURGO shapefile for a selected county. The water regime field is used as 
an indicator of wetness intensity from 0 to 8 with higher numbers indicate wetter, more permanent water regimes.
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Table 11. SSURGO water regime values 
Water Regime  Description Values for Concatenated Field 

0 

All excessively drained, somewhat excessively drained, and well 
drained soils as well as udorthents, udipsamments, pits, and 
gravel. This water regime level also includes moderately well 
drained soils and somewhat poorly drained soils that do not 
flood. 

Null-Null-Null-Null (Pits, Udipsamments); Excessively 
drained-None-None-None; Moderately well drained-
None-None-None; Null-None-None-None; Somewhat 
excessively drained-None-None-None; Somewhat 
excessively drained-Rare-None-None; Somewhat poorly 
drained-None-None-None; Well drained-None-None-
None 

1 

This water regime level includes moderately well drained soils 
and somewhat poorly drained soils that do flood at least rarely. 
(floodplain formations) This is similar to Cowardin’s temporarily 
flooded “A” water regime. 

Moderately well drained-Occasional-None-None; 
Moderately well drained-Rare-None-None; Somewhat 
poorly drained-Frequent-None-None; Somewhat poorly 
drained-Occasional-None-None 

2 
Poorly drained and very poorly drained soils that neither flood 
nor pond. This is similar to Cowardin's saturated “B” water 
regime. 

Poorly drained-None-None-None; Very poorly drained-
None-None-None 

 

3 
Poorly drained soils that occasionally flood during spring (almost 
all floodplain formations). Similar to Cowardin’s “A” or “C” water 
regime depending on the length of flooding. 

Poorly drained-Occasional-None-None 

 

4 
Very poorly drained soils with frequent spring flooding, but no 
ponding (almost all floodplain formations). Similar to Cowardin’s 
seasonal “C” water regime. 

Very poorly drained-Frequent-None-None 

 

5 
Very poorly drained soils with frequent spring flooding and spring 
ponding (almost all floodplain formations). Similar to Cowardin’s 
seasonal “C” water regime. 

Very poorly drained-Frequent-Frequent-None 

 

6 
Very poorly drained soils with no flooding, but that do have 
spring ponding (almost all depressional formations). Similar to 
Cowardin’s seasonal “C” water regime. 

Very poorly drained-None-Frequent-None 

 

7 
Very poorly drained soils with ponding throughout most, if not all 
the year (marsh). Similar to Cowardin’s “F” or “G” water regime. 

Very poorly drained-None-Frequent-Frequent 

 
8 Map units designated as water (non-soil). Similar to “H” WR Null-Null-Null-Null (Water) 



Technical Documentation – NWI Update for East-Central Minnesota 32 
 

 

Percent Hydric Soil Product  

A new field called hydric percent (hydric_pct) was created in the MS Excel worksheet with all soil component data 
(obtained from query 4). The new field is set to zero for soil components that are not hydric (water regime = 0). For soil 
components that are hydric (water regime >0) the hydric percent value is equal to the component percent (comppct). 
The hydric percent data are summarized (sum of hydric_pct) by map unit symbol (the [musym] field) using the pivot 
table function. 

The tabular data from this summary of the hydric soil percent (Sum_Hydric_Pct) worksheet are joined to the SSURGO 
shapefile for Wright County using the [musym] field. The  hydric percent field is used as an indicator of the extent of 
hydric soils from 0% to 100% within each soil map unit. 

 

7.5 Layer stack 
The input to the eCognition segmentation process is a tiff layer stack and the raw spring 2010 aerial imagery. The 
process for creating the tiff layer stack is summarized in Fig. 10.  The NED 10 meter DEM was resampled to 3 meter 
resolution after the derived products were created.  The SSURGO soils derived products were converted to raster format 
and added in the stack.  All layers were clipped to the spring 2010 aerial image boundary.  The final tiff layer stack 
consisted of the following layers: 

1) Combined Curvature 
2) Planimetric Curvature 
3) Profile Curvature 
4) TPI 15 
5) TPI 20 
6) CTI 
7) Palsar 
8) SSURGO Hydric Percentage 
9) SSURGO Water Regime 
10) DEM 
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Figure 10.  Process for creating the Layer stack for input into the segmentation and random forest classification.
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8.0 NWI classification process 
 
The NWI classification process for east-central Minnesota consists of three basic steps:  1) creation of image segments 
(polygons), 2) RandomForest™ classification of the segments, and 3) photo interpretation of the classified image 
segments.  A detailed description of each of the steps is described in the sections below and outlined below and in Fig. 
11.   

The layer stack (described in previous section) and the 2010 spring 4-band imagery was input into eCognition software 
to create the image segments.  The output of the segmentation process consists of two shapefiles; a polygon shapefile 
of the segments and a point shapefile of the centroids of the polygons.  The polygons and points were related using a 
unique identification number (ID).  The point file contains all of the descriptive information from the polygon segments 
and was used as the input into the random forest classification.  Topology was built for the image segments and any 
issues are corrected.  Additional fields (attribute, comments, field verified) were added to the image segments for the 
photo interpretation process. 

A random forest classification was run using the point file and training data (described in section 6 above).  The random 
forest classification classified each point based on the training data and assigned a confidence value to each 
classification.  The resulting classification was then joined to the polygons using the unique ID.  Once the photo 
interpretation process was completed for the quarter quads, those polygons become part of the training data used to 
train the random forest classification for subsequent quads. 

The classified segments were then used to enhance a more traditional photo interpretation of the imagery.  Each of the 
segments was viewed, edited (merged with neighboring segments of the same class or cut to exclude an area), and 
assigned a final NWI classification using a variety of imagery and data (see section 3).  A custom object inspector was 
created to incorporate the information from the random forest classification as well as the soils and Radar 
classifications.  Once a quarter quad was completed, the segments were dissolved based on NWI attribute and run 
through a quality control process that checks for overlaps, gaps and approved NWI codes. 

The draft version of the NWI classification for the quarter quad was sent to the MN DNR for review.  Once the review 
was completed, the quarter quad was merged into a seamless state-wide layer.  The final NWI layer for the east-central 
project area was projected to Albers equal area projection for delivery to the U.S. Fish and Wildlife Service. 
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Figure 11.  The NWI classification process for east-central Minnesota 
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8.1 MN DNR Field evaluation 
An initial field assessment of the classified wetlands was completed by the MN DNR Division of Forestry Resource 
Assessment during the last week in October, 2011.  The primary objective was to provide feedback to the Photo 
Interpreters on the initial wetland classification.  The secondary objective was to identify classes which satisfy the 
peatland modifier in order to provide better examples to the Photo Interpreters.  The results of the field assessment can 
be found in Appendix A. 

8.2 Segmentation 
The spring 4-band imagery and layer-stack files were imported into eCognition software (Trimble 2010) to create the 
image segmentation files.  The eCognition processing rule-set developed for this project contains a sequence of over 250 
separate operations. These operations include: 

1. Initial quad-tree based image segmentation 
2. Sub-processes to manage edge matching between adjacent quads 
3. A multi-resolution image segmentation sequence 
4. Hierarchical image object aggregation by spectral, topographic, and classification based characteristics 
5. Segmentation based re-scaling of the 25m spatial resolution PALSAR layer to make it visually compatible when 

vectored and merged with vectors derived from the 0.5m base imagery 
6. Derivation of contour lines within forested areas based on the DEM layer  
7. Smoothing of all image object boundaries 
8. Elimination of image objects smaller than the specified minimum mapping unit 
9. Export of a final shape file for each quarter-quad  

Improvements to the ruleset and process development were conducted by creating prototype segmentations for the 
photo-interpretation team to review. Suggestions and requests to improve the properties of the segmentation were 
made by the photo interpretation team and incorporated into subsequent versions of the segmentation process.  The 
ultimate goal is to develop eCognition based segmentation and feature extraction processes (Figure 12) that support 
and complement the work done by the photo interpretation team rather than to try to replace human photo-
interpretation entirely.  
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Figure 12. The unedited image segmentation results (red) with two wetland polygons selected (blue) displayed over 
the IR band of the primary 50cm resolution CIR imagery collected for this project 

 

We considered the image segmentation effort to be successful when we reached a point it took less time for an 
interpreter to edit an eCognition derived segmentation shape file for a quarter-quad than it would have taken for that 
interpreter to manually digitize all of the features in that quarter-quad.  The photo-interpretation team now spends the 
vast majority of its time interpreting wetland classes that are difficult to categorize when looking at the imagery. Most of 
the delineation is based on making minor edits to existing polygons rather than on manually creating new polygons for 
each feature. All subsequent segmentation process development efforts were directed toward improving the efficiency 
of the overall workflow in order to further reduce the amount of time required to complete the inventory within each 
quarter-quad.   

An online tracking system was implemented where the photo-interpretation team could request processing of specific 
quarter-quads or suggest improvements to the segmentation process. Overall efficiency was also improved by 
optimizing the rule set for efficient batch processing using the production oriented functions provided by eCognition 
Server software.  All image segmentation based polygons were assigned a unique identification number for tracking and 
to facilitate automated classification of the wetland characteristics with a RandomForest algorithm implemented in the 
R open-source statistical analysis environment (R Development Core Team 2011). Additional fields (attribute, comments, 
field verified) were added to the image segment attribute table to assist in the photo interpretation process. 

 

8.3 Random forest 
The Random Forest classification algorithm is described in detail in Brieman (2001). The random forest classification 
process requires training data as input for the classification process.  The initial training data for the east-central project 
area was aggregated from on-the-ground field work and ancillary data.  In total, 3350 points were used in the initial 
training data set. The breakdown by system and subsystem is shown in Table 12, with a breakdown by full code in 510 
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sites were visited during field work, 1967 were chosen from ancillary datasets, and an additional 873 were identified by 
DU staff from aerial imagery.   

 

 Table 12: Breakdown of training points by system 

 

As each quarter quad was updated, additional training data was merged with the initial training data to create a more 
robust training data set. The predictor variable set included the spectral, DEM, PALSAR and soil map derived features 
that describe each image object polygon. Initial results indicate that the segmentation based Random Forest wetland 
classification separates wetlands from uplands with an overall (bootstrapped) accuracy rate of 92.2% and assigns 
wetland class with an overall (bootstrapped) accuracy rate of 66.87%. These accuracy values should be treated as an 
index only. Whenever the segmentation process is modified based on feedback from the photo-interpretation team the 
current Random Forest classification model becomes obsolete. The algorithm was automatically re-run whenever new 
segmentation files become available which means that classification accuracy values (including those reported here) are 
only useful as transient indices of the utility of the automated classification process. The formal accuracy assessment, 
designed to evaluate data that is ready to submit to the NWI, takes place only after the photo-interpretation and QA/QC 
processes are complete using a separate reference data set collected by the University of Minnesota. Initial results of 
the Random Forest classification are described in Appendix C. 

8.3.1 Wetland Probability Layer 
The WPL (Wetland Probability Layer) is a statistically derived index of the likelihood of wetland occurrence based on 
topographic inputs. All wetland polygons from the East Central NWI update were resampled into a 10m binary raster 
mask indicating wetland presence or absence. All 10m pixels in the mask (roughly 300,000,000) were included in the 
potential training population for a Random Forest ensemble classification algorithm. A series of 0.03% random sub-
samples were drawn from the population to train the RandomForest classifier. Predictor variables were pixel-level 
derivatives of the USGS 10m resolution NED Digital Elevation Model; these were spatially cross-referenced to the 
training mask. The predictor variable set included: elevation, slope, catchment area and Compound Topographic Index 
(CTI= LN(([FlowAcc_Dem] + 0.001) / (([Slope_Dem] / 100) + 0.001))). CTI inputs were calculated with TauDEM using the 
D-infinity method. The result from the RandomForest classification was an index ranging from 0 to1 indicating the 
likelihood of any pixel in the population belonging to the class “wetland” based on solely on topographic predictors. The 
internal (OOB) estimate of error rate for the RandomForest classifier was 26.28% with an upland class error rate of 
15.5% and a wetland class error of 49.68%.  

 

Classification Total 
Palustrine:     

  Forested 359 
  Scrub-Shrub 103 
  Emergent 1029 
  Aquatic Bed 311 
  Unconsolidated Bed 547 

Lacustrine: 
 

  
  Aquatic Bed 18 
  Unconsolidated Bed 39 

Riverine: 
 

  
  Unconsolidated Bed 22 

Upland:   796 
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Wetland Probability Layer Confusion matrix: 
Upland     Wetland  class.error 

Upland   57919   10675     0.1556259 
Wetland 15605   15801     0.4968796 
 

8.4 Photo interpretation 
A detailed list of steps for the photo interpretation process is listed in Appendix C. 

8.4.1 Photo interpretation guide 
A photo interpretation guide has been created to assist interpreters and help standardize NWI update methodology. 
This guide includes a brief description of the wetland class and is followed by a representative photo taken during the 
field training data process, as well as aerial imagery for spring and summer in CIR and natural color. These images will 
help the interpreter identify wetland types by viewing ground photos with paired aerial photos for the same wetland 
type.  

8.4.2 Custom object inspector 
A custom object inspector was created within ArcMap in order to make the photo interpretation process more efficient 
(Fig. 13).  The custom object inspector allows the interpreter to view the attributes from the random forest 
classification, soils, and Radar classification as well as providing drop-down menus for the Attribute and field verification 
fields. 

 

 

Figure 13. The custom object inspector for the east-central project area 
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8.4.3 Photo interpretation process 
The photo interpreters viewed the segments over the spring 2010 imagery to identify wetland segments. The photo 
interpreters used the spring imagery, professional knowledge, photo interpretation guide, information provided by the 
object inspector, as well as the summer imagery to assign the NWI code.  Additional data layers (USGS DRG, Radar 
classification, SSURGO soils, DEM) were also available to assist with the NWI classification.  Adjacent segments of the 
same class were merged.  Segments that have multiple wetland classes or combine wetland and upland classes were cut 
into separate polygons to conform to the NWI class boundary.  Each quarter quad was interpreted systematically until 
the entire area had been completed. Additional details for the photo interpretation process are provided in Appendix A. 

8.4.4 Quality assurance and quality control 
Quality control and quality assurance (QA/QC) programs were written to automatically check for topological (gaps and 
overlaps) and attribute errors within the classification after the photo interpretation process was complete.  Once a 
quarter-quad was completed, the interpreter executes the QA/QC program and corrects any identified errors before 
moving on to another quarter-quad.  After successful execution of the QA/QC process by the interpreter, a second 
interpreter inspected 10% of the wetland classification to ensure consistency and accuracy of the wetland classification 
between individual interpreters. After the second review, the NWI QA/QC analyst reviewed the overall classification for 
that quarter-quad and executes a second series of automated QA/QC procedures provided by the USFWS. 

The draft version of the NWI classification for the quarter quad was then sent to the Minnesota Department of Natural 
Resources for review.  Errors found through the DNR review process were addressed prior to final production. Additional 
information on the DNR QA/QC review can be found in the Quality Assurance Project Plan for the National Wetland 
Inventory of Minnesota (DNR 2010). 

Once the review was completed, the quarter quad was merged into a seamless state-wide layer.  Final accuracy of the 
NWI update will be calculated by a third party organization (The University of Minnesota) not directly involved in the 
mapping process. The formal accuracy assessment was based on comparing updated NWI polygons to a field reference 
data source that was created and maintained separately from the reference data sources used in the production 
mapping process.  

8.4.5 Merge with seamless layer 
After completion of the QA/QC of the quarter quad, the data was merged into a seamless NWI layer for the east-central 
project area. 

8.4.6 Final product generation 
Before final product generation, the photo interpreted segments were generalized to “smooth” the polygons so they 
look more natural for the end user. This smoothing process also removes unnecessary vertices, thus reducing the 
storage requirements and improving the overall efficiency of the data.  The final product was delivered in an Albers 
Equal Area projection for conformance to the FWS standard as well as the Universal Transverse Mercator projection to 
conform to the Minnesota standard for geospatial data. 
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9.0 Simplified Plant Community Classification system  
In addition to the Cowardin classification system, the NWI update for Minnesota included the addition of a simplified 
plant community classification based on the classification of Eggers and Reed (1997).  The 15 plant community classes 
from Eggers and Reed were re-grouped into nine simplified plant community classes with one additional class for non-
vegetated aquatic communities (e.g. substrate types for certain systems/sub-systems including unconsolidated bottom, 
rock bottom, rocky shore, unconsolidated shore, and streambed). This simplification of the Eggers and Reed 
classification system was designed to provide information on wetland plant communities to the end users of the 
updated NWI within the bounds of what was currently possible to achieve with reasonable accuracy with remote 
sensing data. The simplified plant community classes are summarized in Table 13. 

9.1 Combining Classes 
1) Combine the Sedge Meadow, Fresh Wet Meadow, Wet to Wet-Mesic Prairie, and the herbaceous form of the 

Calcareous Fen into a single simplified Inland Wet Meadow class. 
2) Combine the various bog types and subtypes of Eggers and Reed into a single simplified Peatland class. 
3) Combine the Shrub-Carr, Alder Thicket, and the shrub form of the Calcareous Fen into a single simplified Shrub 

Wetland class. 
Table 13: Simplified plant community classes 

 Modified Plant Community Class Eggers and Reed Plant Community Class 
1 Seasonally Flooded Basin Seasonally Flooded Basins - 16B 
2 Wet Meadow Sedge Meadow - 13A 

Fresh (Wet) Meadows - 15B 
Wet to Wet-Mesic Prairies - 15A 
Calcareous Fens (Herbaceous Type) - 14A 

3 Shallow Marsh Shallow Marshes - 13B 
4 Deep Marsh Deep Marshes - 12B 
5 Shallow Open Water Community Shallow Open Water Communities -16A 
6 Peatland Open Bog (Herbaceous Type) - 10A 

Open Bog (Shrub Type) - 7A 
Coniferous Bogs - 4A 

7 Shrub Wetland Shrub-Carrs - 8B 
Alder Thickets - 8A 
Calcareous Fens (Shrub Type) - 7B 

8 Hardwood Wetland Hardwood Swamps - 3B 
Floodplain Forests - 3A 
 

9 Coniferous Swamps Coniferous Swamps - 4B 
 

10 Non-Vegetated Aquatic Community NA 
 

9.2 Classification cross-walk to Cowardin 
Implementing this simplified plant community class was primarily a process of re-coding from the Cowardin classification 
system including wetland classes, subclasses, water regime modifiers, and special modifiers to the simplified plant 
community class. The applicability of the cross-walk between the Cowardin classification system and the simplified plant 
community classification system requires special attention to how the Cowardin codes were applied. This cross-walk is 
summarized in Table 14. 
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1) Split the Cowardin palustrine emergent class (PEM) across four simplified plant community classes based on 
water regime; Seasonally Flooded Basins (PEMA), Inland Wet Meadow (PEMB), Shallow Marshes (PEMC & 
PEMF), and Deep Marshes (PEMH).  

2) There is some potential for class confusion between simplified Inland Wet Meadow class and the Seasonally 
Flooded Basin class. Particular attention is required during the photo-interpretation of the temporarily flooded 
(A) water regime for the PEM class to ensure proper class separation. The Eggers and Reed classification key 
states that Seasonally Flooded Basins are often cultivated or dominated by annuals such as smartweed and wild 
millet. Wetlands with photo-signatures indicating dominant plant communities are obligate wetland species 
(such as Typha) should not be classified as PEMA. 

3) Split the Cowardin PAB class across Deep Marshes (PABF) and Shallow Open Water Communities (PABH) based 
on water regime.  

4) Split the Cowardin forested wetland class (PFO) into Coniferous Wetland (PFO2 & PFO4) and Hardwood Wetland 
(PFO1) plant community classes based on sub-class with the exception of the coniferous wetlands that should be 
placed in the peatland class (see rule 5). 

5) The peatland community class crosses the PEM, PSS, and PFO Cowardin classes. Additional interpretation 
beyond what is typically required for the NWI is needed to effectively separate the peatland community class. 
Wetlands that have photo-signatures that indicate closed canopy black spruce stands, sphagnum-moss/leather-
leaf, sphagnum/sedge, sphagnum/tamarack, or possessing other peatland indicators such as the characteristic 
open water moat will be assigned a new special modifier (q) that will then be used to complete the cross-walk 
for the simplified peatland community class. 
 

NOTE: This class is most closely related the Eggers and Reed bog classes, but the relationship is not expected to be perfect. According 
to Eggers and Reed, bogs have the following plant characteristics: 

• Tamarack (PFO2) and/or black spruce (PFO4)  are dominant; growing on a continuous sphagnum moss mat and acid, peat 
soils 

• Shrubs are ericaceous and evergreen (PSS3, PSS4) growing on a sphagnum moss mat layer; peat soils are acidic 

• Sphagnum moss mat on acid peat soils; leatherleaf, pitcher plants, certain sedges, and other herbaceous species (PEM) 
tolerant of low nutrient conditions may be present 

The presence of a sphagnum moss mat and ericaceous shrubs can usually be photo-interpreted. In some cases, the tree canopy can 
be too dense to view the underlying layers. However, depending upon the characteristics of the tree canopy, the presence of a 
sphagnum mat can be inferred. The Native Plant Community Classification System refers to some wetlands with extensive sphagnum 
coverage as poor fens. Eggers and Reed does not make this distinction. These poor fens are difficult to separate from bogs without 
detailed field studies. In fact, fens and bogs may occur within the same wetland complex. 
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Table 14: Cross-walk from Cowardin to simplified plant community type 

System Subsystem Class Subclass Water Regime Code Modifier Plant Community Class 

Lacustrine 

Limnetic 

Rock Bottom   H L1RBH   Non-Vegetated Aquatic Community 

Unconsolidated Bottom   H L1UBH   Non-Vegetated Aquatic Community 

Aquatic Bed   H L1ABH   Shallow Open Water Community 

Littoral 

Rock Bottom 
  F L2RBF 

  Non-Vegetated Wetland 
H L2RBH 

Unconsolidated Bottom 
  F L2UBF 

  Shallow Open Water Community 
H L2UBH 

Aquatic Bed 
  F L2ABF 

  Shallow Open Water Community 
H L2ABH 

Rocky Shore 
  A L2RSA 

  Non-Vegetated Aquatic Community 
C L2RSC 

Unconsolidated Shore 
  A L2USA 

C L2USC 

Emergent 2-Nonpersistent 
F L2EM2F 

  Shallow Open Water Community 
H L2EM2H 

Riverine 

Lower Perennial 

Rock Bottom 
  F R2RBF 

  Non-Vegetated Aquatic Community 
H R2RBH 

Unconsolidated Bottom 
  F R2UBF 

  Non-Vegetated Aquatic Community 
H R2UBH 

Aquatic Bed 
  F R2ABF 

  Shallow Open Water Community 
H R2ABH 

Rocky Shore 
  A R2RSA 

  Non-Vegetated Aquatic Community 
C R2RSC 

Unconsolidated Shore 
  A R2USA 

C R2USC 

Emergent 2-Nonpersistent 
F R2EM2F 

  Shallow Open Water Community 
H R2EM2H 

Upper Perennial 

Rock Bottom 
  F R3RBF 

  Non-Vegetated Aquatic Community 
H R3RBH 

Unconsolidated Bottom 
  F R3UBF 

  Non-Vegetated Aquatic Community 
H R3UBH 

Aquatic Bed 
  F R3ABF 

  Shallow Open Water Community 
H R3ABH 

Rocky Shore 
  A R3RSA 

  Non-Vegetated Aquatic Community 

C R3RSC 

Unconsolidated Shore 
  A R3USA 

C R3USC 

Intermittent Streambed 
  A R4SBA 

C R4SBC 
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Table 14– Cross-walk from Cowardin to simplified plant community type 
(continued) 

System Subsystem Class Subclass Water Regime Code Modifier Plant Community Class 

Palustrine Palustrine 

Rock Bottom 
  F PRBF 

  Non-Vegetated Aquatic Community 
H PRBH 

Unconsolidated Bottom 
  F PUBF 

  Shallow Open Water Community 
H PUBH 

Aquatic Bed 
  F PABF   Deep Marsh 

H PABH   Shallow Open Water Community 

Unconsolidated Shore 
  A PUSA 

  Non-Vegetated Aquatic Community 
C PUSC 

Moss-Lichen  B PMLB q Peatland 

Emergent 

1-Persistent 

A PEM1A   Seasonally Flooded Basin 

B PEM1B 
not q Wet Meadow 

q Peatland 

C PEM1C 
  Shallow Marsh 

F PEM1F 

2-Nonpersistent 
F PEM2F 

  Deep Marsh 
H PEM2H 

Scrub-Shrub 

1-Broad-leaved deciduous 

A PSS1A 

  Shrub Wetland B PSS1B 

C PSS1C 

2-Needle-leaved deciduous 

A PSS2A   Shrub Wetland 

B PSS2B 
not q Shrub Wetland 

q Peatland 

C PSS2C   Shrub Wetland 

3-Broad-leaved evergreen B PSS3B q Peatland 

4-Needle-leaved evergreen 

A PSS4A   Shrub Wetland 

B 
PSS4B not q Shrub Wetland 

PSS4B q Peatland 

C PSS4C   Shrub Wetland 

Forested 

1-Broad-leaved deciduous 

A PFO1A 

  Hardwood Wetland B PFO1B 

C PFO1C 

2-Needle-leaved deciduous 

A PFO2A   Coniferous Wetland 

B PFO2B 
not q Coniferous Wetland 

q Peatland 

C PFO2C   Coniferous Wetland 

4-Needle-leaved evergreen 

A PFO4A   Coniferous Wetland 

B PFO4B 
not q Coniferous Wetland 

q Peatland 

C PFO4C   Coniferous Wetland 

Water regimes shaded blue are the most likely regime for the associated Cowardin class 
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9.3 Data processing for SPCC 
Geoprocessing functionalities within ArcGIS were utilized to generate a script to populate the SPCC based on the NWI 
code (Fig. 14).  There were no additional input data, hardware and software required. The script can be run under any 
ArcGIS desktop environment.  The following lists the detailed steps of developing, testing, deploying, and distributing 
the script. 

 

(1) Write the python script in Notebook and saved it into a .py file.  
(2) Test the script and check the field to see if it’s correctly populated.  
(3) Import into ArcToolbox as an arctool with a user-friendly interface.  

 

 

Figure 14.  An example of part of the SPCC code. 
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10.0 Simplified key for hydro-geomorphic classification  

10.1 HGM Classification Overview 
A simplified Hydro-Geomorphic (HGM) Classification was created for the updated NWI for Minnesota based on the rules 
listed in this section (see Fig. 16-19).  A geoprocessing script was created to automate the simplified HGM classification 
for the East-Central Project Area.  The script was tested on one of the NWI quads in the East-Central Project Area and 
reviewed by DU and the MN DNR.  The HGM script was refined based on the review comments from MN DNR until an 
acceptable solution was found.  Every polygon in the NWI data layer has an HGM attribute for landscape position, 
landform/waterbody, and water flow path. The allowable classes are provided in Table 15. 

Table 15– Allowable HGM classes for the East-Central Project Area 

Landscape Position Landform/Waterbody Water Flow Path 
Lentic 
Lotic River 
Lotic Stream 
Terrene 

Island 
Fringe 
Floodplain 
Basin 
Flat 
Slope 
 

Inflow 
Outflow 
Throughflow 
Bi-directional Non-tidal 
Isolated 

Lake 
River 
Pond 

 

 

10.2 Data Requirements and Layer Generation 
The required data layers to perform the HGM classification on the updated NWI are: 

(1) DEM 
(2) Hydrology  
(3) Public Water Inventory Basin Delineations 

 
The DEM layer was a combination of the Lidar derived DEM (3 meter) and the National Elevation Dataset (10 meter) (see 
section 4.2.4).  The hydrology layer was from the MN DNR hydrology layer 
(http://deli.dnr.state.mn.us/metadata.html?id=L260000072102) for the height above streams analysis and determining 
the water flow path.  The Public Water Inventory Basin Delineations was downloaded from the MN DNR Data Deli 
(http://deli.dnr.state.mn.us/metadata.html?id=L390006600201). 

Three derived layers from the DEM are also required to perform the HGM classification.  A “height above streams” layer 
was derived from the DEM in order to determine the floodplain delineation.  A “depressions” layer was derived from the 
DEM in order to identify the basin landform and a Slope (> 2%) layer was derived from the DEM in order to identify the 
slope landform. 

10.2.1 Height Above Streams 
There are many important ecological, environmental, and engineering issues of interest that occur within the riparian 
zone of rivers and streams. These areas can be important areas for biodiversity, sediment erosion and deposition, as 

http://deli.dnr.state.mn.us/metadata.html?id=L260000072102�
http://deli.dnr.state.mn.us/metadata.html?id=L390006600201�
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well as flooding. Riparian ecosystems include the zone that occurs within the banks of a river or stream as well as the 
adjacent areas that are periodically influenced by flooding.  

This section describes a GIS-based process for creating a modified digital elevation model (DEM) that depicts the height 
of land relative to the nearest stream or river course. The resulting modified DEM is referred to as height-above-stream 
(HAS) and it has potential value in helping to define the extent of the riparian zone adjacent to a defined set of streams 
or rivers. However, this analysis should not be confused in any way with floodplain maps derived from detailed 
engineering studies, on-site surveys, or hydrologic and hydraulic models.  The steps to perform a HAS analysis are 
outlined in Table 16. 

The data required to perform the HAS are a Digital elevation model, preferably be a high-resolution DEM derived from 
LiDAR and a river and stream centerline data.  Careful consideration should be given to the features included in the 
rivers and stream data set.  Existing data for river and streams typically also include other hydrologic features that may 
or may not be relevant to this analysis, such as storm sewers, aqueducts, and drainage ditches.  Only the features that 
are relevant to the analysis should be extracted from the dataset prior to analysis (e.g. perennial rivers and streams). 
Also, errors in the linework may create errors in the output. For example, if the digitized stream line lies outside the 
bank of the stream as defined on a LiDAR-derived DEM, then the base elevation will be too high for that location. 

 

Figure 15.  A ModelBuilder Model of the HAS Processing Steps. 

 
Table 16– Steps to Perform a Height Above Stream Analysis 

1) Open ArcGIS and ensure that the Spatial Analyst extension is turned on 
(Customize>Extensions…) 

2) Open the ArcToolbox window. 
3) Extract the desired stream/river features for the project area from a stream GIS data 

layer such as DNR 24K Streams or the National Hydrography Dataset (NHD) for your 
desired project area (e.g. Analysis Tools>Extract>Clip).  

4) Extract, clip, or mosaic the DEM as needed to match your project extent (e.g. Spatial 
Analyst Tools>Extraction>Extract by Rectangle). 
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5) Use the “Copy Raster” tool to set 0 values to Null (Data Management>Raster>Raster 
Dataset>Copy Raster). 

6) Calculate the slope grid from the DEM selecting the output to be expressed as percent 
slope not degrees (Spatial Analyst>Surface>Slope). Make sure that the vertical and 
horizontal units are the same, or use a conversion factor to make the units the same. 

7) Use raster calculator to convert the percent slope to fractional slope (rise/run) by 
dividing by 100 (Spatial Analyst Tools>Map Algebra>Raster Calculator). 

8) Run a cost-distance analysis (Spatial Analyst Tools>Distance>Cost Distance). The source 
data is the selected stream/river features extracted in step three. The cost raster is the 
fractional slope grid created in step six. 

9) In order to convert the raster to polygons and manipulate the features (dissolve, select, 
etc), first convert the raster values to integer (Spatial Analyst Tools>Math>Int).  

10) To remove values more than a certain height above the stream, use a con statement 
(Spatial Analyst Tools>Conditional>Con). The input raster is the integer raster created in 
step 10, the expression is the SQL expression to select only the values you want in the 
output (e.g., VALUE <= 3), the input true raster is the same as the input raster, and the 
input false raster should be left blank. This means that if a pixel is less than or equal to 3 
(meters above stream), the output includes that pixel, but if the value is 4 or greater the 
output does not include that pixel. 

11) Convert the raster layer to polygon features (Conversion Tools>From Raster>Raster to 
Polygon). 

The cost-distance tool calculates the least accumulative cost distance for each cell to the nearest source over a cost 
surface. In this instance the stream or river centerline feature is the source so the “cost” is set to zero for every grid cell 
that touches a river or stream feature. The algorithm first multiplies the distance across a cell from the source by the 
fractional slope (rise/run) to get the incremental height increase for each cell. As the algorithm progresses outward from 
the source, the value for each cell is determined by adding this incremental height to the lowest adjacent value. This is 
analogous to the way that water would spread out from the stream or river during a flood. This data can be combined 
with historic information on stream stage to estimate the extent of the riparian zone, if local stream gauging data are 
available and if vertical benchmarks exist to relate stream stage to local elevation. 

10.2.2 Depressions 
A depressions layer derived from a DEM will be created to represent depressions in the overall landscape.  This layer will 
be used to identify basins in the landform part of the HGM classification.  The only input required to create the 
depressions layer is a DEM (see section 4.2.4).  Table 17 describes the process for creating the depressions layer. 

Table 17– Steps to Create the Depressions Layer 

1. Convert raster from meters to feet:  using Spatial Analyst > Math > Divide, divide raster 
by the constant value 0.3048 

• Input raster or constant value 1: Original DEM 
• Input raster or constant value 2: 0.3048 
• Output raster: DEM_ft 

2. Preserve decimal points: using Spatial Analyst > Math >  Times, multiply raster by the 
constant value 1000 

• Input raster or constant value 1: DEM_ft 
• Input raster or constant value 2: 1000 
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• Output raster: DEM_ft_1000 
3. Convert raster value to a useable value: using Spatial Analyst > Math > Int 

• Input raster or constant value: DEM_ft_1000 
• Output raster: Int_DEM 

4. Fill all depressions in the raster: Spatial Analyst > Hydrology > Fill 
• Input surface raster: Int_DEM 
• Output surface raster: Fill_DEM 

5. Create a new raster layer whose values represent the distance between the original DEM 
and the Filled DEM:  Spatial Analyst > Math > Minus; input value 2 (original DEM) will be 
subtracted from input value 1 (filled DEM) 

• Input raster or constant value 1: Fill_DEM 
• Input rater or constant value 2: Int_DEM 
• Output raster: Dep_DEM 

6. Reclassify the raster: Spatial Analyst > Reclass > Reclassify  
• Input raster: Dep_DEM 
• Reclass Field: Value 
• Reclassification: Select classify button, method: Standard Deviation (1) 
• Output raster: Dep_Reclass 

7. Convert the layer from Raster to Polygon: Conversion Tools > From Raster > Raster to 
Polygon 

• Input raster: Dep_Reclass 
• Field: Value 
• Output Polygon features: Dep_poly    

*** Simplify polygons box should be checked. 
8. Add  Field:  Data Management Tools > Fields > Add Field 

• Input table: Dep_poly 
• Field Name: Acres 
• Field Type: Double 

9. Calculate Acres: Data Management Tools > Fields > Calculate Field 
• Input Table: Dep_poly 
• Field Name: Acres 
• Expression: !shape.area@acres! 
• Expression Type: Python_9.3 

 

The resulting data will have roughly 3 classes, depending on the elevation variance within the landscape.  GRIDCODE 3 
will represent the lowest depressions; GRIDCODE 2 will represent shallow depressions and transitional areas, while 
GRIDCODE 1 will represent areas with the highest elevations. GRIDCODE values higher than 3 may be present depending 
on the elevation variance within the dataset. In cases such as this, the highest GRIDCODE value will represent the 
deepest depressions and as GRIDCODE values decrease so does the depth of the depression. 

 

10.2.3 Slope 
In order to determine if a wetland should be considered a slope landform, a slope layer was created from the DEM.  A 
vector layer was then created from the slope layer that contains two classes (>2% slope and <=2% slope). 
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10.3 HGM Classification Process 
The General steps for creating the script to create the HGM classification include: 

(1) LANDSCAPE POSITION (Fig. 16): Make a feature layer of river/stream using the MN DNR hydro flow line data. 
Create a feature layer of lake/reservoir layer from all the Lacustrine wetlands of the NWI layer. Select the 
wetland polygons (all except for Lacustrine and Riverine wetlands) and make a feature layer of them. Loop 
through each wetland polygon to intersect the DNR river/stream, NWI Riverine wetlands and lake/reservoir 
layers. If there are no intersected water features for a wetland polygon, the Landscape field value becomes 
“Terrene”. If the intersected water features are lakes or reservoirs only, update the Landscape field with the 
value “Lentic”. If the intersected water features are NWI Riverine wetland polygons, further check to see if the 
intersected Riverine wetland flow through the wetland polygon. If the intersected Riverine wetland start or end 
at this wetland polygon, update the Landscape field with the value “Terrene”. If the intersected Riverine wetland 
flow through or alongside the wetland and the wetland intersects a floodplain, update the Landscape field with 
the value “Lotic River”.   If the intersected water features are river/streams from the DNR layer, further check to 
see if the intersected river/streams flow through the wetland polygon. If the intersected river/stream start or 
end at this wetland polygon, update the Landscape field with the value “Terrene”. If the intersected rivers or 
streams flow through or alongside the wetland and the wetland intersects a floodplain, update the Landscape 
field with the value “Lotic Stream”.   If the wetland doesn’t intersect any floodplains, update the landscape field 
with the value “Terrene”.  
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Figure 16.  Landscape Position Decision Tree. 
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(2) LANDFORM (Fig. 17): Create a feature layer of water bodies from the unconsolidated bottom or aquatic bed 

wetlands of the NWI layer. Select the wetland polygons (all except for Lacustrine and Riverine wetlands) and 
make a feature layer of them.  If the wetland polygon is completely contained by a water polygon, update the 
landform field with the value “Island”. If the wetland polygon is not completely contained by a water polygon 
and it intersects permanent water bodies, update the landform field with the value “Fringe”.   If the Fringe 
wetlands have water regime classes of “A” then recode landform to “Flat”.  If the wetland polygon doesn’t 
intersect any water bodies, but it is one of these types wetlands (R1US, R2US, R3US, R4US), update the landform 
field with the value “Fringe”.  If the wetland polygon doesn’t intersect any water bodies and it is not one of 
these wetlands (R1US, R2US, R3US, R4US), further check to see if it intersects any floodplains. If it intersects a 
floodplain, update the landform field with the value “Floodplain”.  If it doesn’t intersect any floodplains, but it 
intersects a depression, update the landform field with the value “Basin”. Loop through each wetland polygon to 
intersect the slope layer. If at least half of the wetland occurs on a slope >2%, update the landform field with the 
value “Slope”. Otherwise, update the landform field with the value “Flat”.  

 

 
 

 
Figure 17.  Landform Decision Tree. 
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(3) Water Flow Path (Fig. 18): Create a feature layer of lake/reservoir layer from all the Lacustrine wetlands of the 
NWI layer. Select the wetland polygons (all except for Lacustrine and Riverine wetlands) and make a feature 
layer of them. Loop through each wetland polygon to intersect the river/stream and lake/reservoir layers. If 
there are no intersected water features for a wetland polygon, the WaterFlowPath field value becomes 
“Isolated”. If the intersected water features are lakes/reservoirs only, update the WaterFlowPath field with the 
value “Bidirectional-Nontidal”. If the intersected water features are rivers or streams only and all of them end at 
the wetland polygon, update the WaterFlowPath field with the value “Inflow”. If all of the intersected rivers and 
streams start at and flow out of the wetland, update the WaterFlowPath field with the value “Outflow”. If the 
intersected rivers and streams flow through the wetland, update the WaterFlowPath field with the value 
“Throughflow”.  Reclassify wetlands classified as “Isolated” above into “Bidirectional-Nontidal” if they intersect a 
“Bidirectional-Nontidal” wetland. Reclassify wetlands classified as “Isolated” above into “Inflow” if they intersect 
an “Inflow” wetland. Reclassify wetlands classified as “Isolated” above into “Outflow” if they intersect an 
“Outflow” wetland.  

 

 
 

Figure 18.  Water Flow Path Decision Tree. 
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(4) General Recodes (Fig. 19):  The general recoding was done to directly assign HGM codes to specific NWI classes 
and to correct some HGM codes that were mislabeled in the scripting process.  All lacustrine wetlands were 
selected and given a landscape position of “Lentic”, landform of “Lake”.  In order to assign a Water Flow Path to 
the Lacustrine wetlands, the PWI layer was used to identify the Water Flow Path using a process similar to the 
Water Flow Path script.  All Lacustrine wetlands were then assigned the Water Flow Path from the 
corresponding PWI layer.  All riverine wetlands were given the following: “Lotic River, River, Throughflow”.  All 
palustrine unconsolidated bottom or aquatic bed wetlands were given a landform of “Pond”.  All “Fringe” 
wetlands were given a water flow path of “Bidirectional – Nontidal”.  All “Lotic River Outflow” wetlands were 
changed to “Terrine Outflow”.  All “Terrine Floodplain Isolated” wetlands were changed to “Lotic River 
Floodplain Isolated”. 

 
 

 
 

 
 

Figure 19.  General Recodes. 
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(5) Combine the three fields (Landscape, Landform, and WaterFlowPath) into the simplified HGM classification and 

crosswalk to the HGM codes (Table 18).  
 
 
 
 

Table 18– HGM description crosswalk to HGM codes 

  

Landscape Position Landform/Waterbody Water Flow Path
NAME CODE NAME CODE NAME CODE

Lentic LE Island IL Inflow IN
Lotic River LR Fringe FR Outflow OU
Lotic Stream LS Floodplain FP Throughflow TH
Terrene TE Basin BA Bi-directional Non-tidal BI

Flat FL Isolated IS
Slope SL

Lake LK
River RV
Pond PD
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Appendix A: MN DNR NWI Field Verification Report 
 

NWI Field Verification Report 

MN DNR Division of Forestry Resource Assessment 

November 15, 2011 

 

Introduction 

An initial field assessment of classified wetlands was completed during the last week in October, 2011. 
The primary objective of the field work was to verify the classification of wetland classes according to the 
Cowardin Classification System. The secondary objective was to identify classes which satisfy the peatland 
modifier. The field assessment started with 89 wetland polygons for class verification. In total, 45 wetland 
polygons were visited. Out of the remaining polygons; 12 were not visited due to time constraints and 32 were 
inaccessible. 

Field Data 

Prior to the field work, photo interpreters from Ducks Unlimited identified wetland polygons. The 
majority of wetland polygons were attributed with an appropriate Cowardin Classification which included 
[System - Class – Subclass - Water Regime - Special Modifiers] according to Figure 1b Wetlands and 
Deepwater Habitats Classification from the FGDC Wetlands Mapping Standard. The pre-field work 
classification was assigned under the field identified as ‘PI_Class’. In the field, an assessment of the 
classification was made and noted in the ‘Field_Clas’. The field observations can be re-visited in the office by 
looking at the associated photos taken in the field, as indicated by the ‘Photo_num’ field. Additionally, there is 
a point shapefile which illustrates the point at which each photo was taken. The wetland polygons where the 
class is different between the ‘PI_Class’ and the ‘Field_Clas’ are flagged by the ‘Class_diff’ field with a ‘1’. 

Summary 

Out of the total 45 polygons visited in the field, there were 16 polygons where the original and the field 
verified classification differed. The table below identifies the 16 polygons where the classification differed 
between the photo interpreted classes and the classes assigned in the field.  

Wetland ID PI Class Field Class Wetland ID PI Class Field Class 
6 PFO4Bq PFO2/4Bq 51 PFO2Bq PFO1C 
12 PUBGx PUBFx 54 PFO4C PFO1C 
14 PEM1A PEM1Ad 57 PEM1F PFO1C 
23 PEM1Af PEM1A 61 PEM1C PABF 
41 PFO1A PSS1B 64 PFO4C PSS1C 
42 PFO2Bq PFO1/2B 72 PFO2/4q PFO2Bq 
43 PABG PABF 73 PFO2/4Bq PFO2Bq 
47 PFO2Bq PFO2B 84 PFO2/ML1Bq PSS2/3Bq 
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Based on the field observations, the following are recommendations for continuing NWI classification 
via photo interpretation methodology. 

- All of the peatlands (without trees) that were visited had low growing ericaceous shrub layer (mostly 
leather leaf). As such, it would be more appropriate to use the PSS3 class rather than the PML1 
class. It is assumed that this is fairly typical for open peatlands in this region.  

- A couple of the wetlands visited where given a mixed class assignment of PFO2/4 assuming that 
there was a mixture of Tamarack and Black Spruce when in fact there was very little Black Spruce. 
Some additional effort is probably warranted to separate the signatures of Tamarack and Black 
Spruce. Fall peak-color imagery may be available and useful.  

- Avoid using the ‘G’ water regime and instead use ‘F’ or ‘H’ – according to the 4th bullet under 
general guidance for water regime on p. 17 of NWI Technical Documentation. 

- PFO4 – several of these were actually PFO1 – can be easily mistaken in spring imagery where the 
deciduous has leafed out. Carefully distinguish deciduous from conifer foliage. 

- PSS vs. PFO – difficult to differentiate in some cases without stereo – particularly for wetlands with 
young or stunted trees. 

Follow-up 

The Resource Assessment staff will continue to collaborate with Ducks Unlimited to verify NWI 
classification. The second field assessment of NWI classification in the metro study area will occur in Spring 
2012 after more wetlands have been identified and classified.  

 

 

Division of Forestry - Resource Assessment 
483 Peterson Rd. Grand Rapids, MN 55744 

Main office ph. 218-322-2500 
 

Contact: 
Molly Martin, Image Analyst 

molly.martin@state.mn.us 
Direct ph. 218-322-2514 

 

  

mailto:molly.martin@state.mn.us�
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Appendix B: Initial Random Forest Results 
A series of RandomForest™ models were developed to classify polygons generated via image segmentation into 
Wetland/Upland, NWI class, and water regime categories. Seven hundred twenty-seven training points were used as the 
response values required to build each model.   The Predictor variable set includes the DEM, spectral, PALSAR and soil 
map derived features that describe each polygon (insert table reference).  

The following tables and plots are generated by the RandomForest Algorithm using internal error estimation techniques 
(bootstrapping) this information does not represent external validation using independent data.  

Both the contingency tables and plots report the error rate. The classification accuracy is one minus the error rate.  
Variable importance plots express the decrease in accuracy associated with withholding a particular variable from a 
subset of trees in the forest. When a particular variable is withheld and the trees without it register a lower accuracy 
rate than trees that include it, its importance is understood to be high. To interpret the plots, it is only necessary to note 
that the variables on the top of the plot are most important in terms of forest level classification accuracy and those on 
the bottom are least important.  

 A second set of RF models were generated with the CTI variables entirely removed from the predictor set in order to 
compare the overall forest level accuracy estimates.  

 

Overall OOB error rate With CTI W/O CTI 

Wetland/Upland 7.8% 6.96% 

Class 34.09% 33.13% 

Water Regime 36.61% 37.45% 

   

 

Given the marginal effect of adding the CTI variables and the additional time required to generate the hydrologically 
conditioned DEM, using CTI from the hydorlogically conditioned DEM is not warranted.  

Key to the Variable Importance Plot Abbreviation System 
Features  Calculations 

CIR4 Color IR (Band 4) MN Object level Mean value of feature pixels 

PROF Profile Curvature SD Object level Range (Max -Min) of feature pixel values  

CURV Curvature RG Object level Standard Deviation of feature pixel values  

PLAN Plan Curvature RTO Band Ratio 

DEM Raw Elevation Values SUM Object level mean of Sum of multiple features  

TPI15 Topographic Position Index (15 pixel window) 
  CTI Compound Topographic Index 
  PLSR PALSAR Binary Value 
  Bright Overall Brightness (sum of spectral values) 
  MAXDIF Maximum Difference in spectral values 
      

 

 



60 
 

 

 

 

 

 



61 
 

 

 



62 
 

 

 

 

 

 



63 
 

Appendix C: Photo Interpretation Process 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

1. Data layers are feed into eCognition segmentation software at GPRO(Great Plains Regional Office) 
a. Combined Curvature 
b. Planimetric Curvature 
c. Profile Curvature 
d. TPI 15 
e. TPI 20 
f. CTI 
g. Palsar 
h. SSURGO Hydric % 
i. SSURGO Water Regime 
j. DEM 
k. Spring 2010 aerial imagery 

2. eCognition exports to GLARO 
a. segment polygon shapefile  

i. named quadname_polys  (q3131ne_polys) 
a. W:\GreatLakes_NWI_Update\MN\EcognitionOutput\polys 
b. Fields 

i. COORID  (double) 
ii. ACRES 

c. To be loaded into  MN_NWI Feature Dataset 
b. Point shapefile 

i. named quadname_points (q3131ne_points) 
a. W:\GreatLakes_NWI_Update\MN\EcognitionOutput\points 
b. Fields 

i. COORID  (double) 
ii. All the export fields from eCognition 

c. To be used in Random Forest 

 3. Import Script   
a. Input – all polygon shapefiles in W:\GreatLakes_NWI_Update\MN\EcognitionOutput\polys 
b. Backs up shapefiles to external hard drive (\\GLARO_SDE\Backup\NWI_Backup\ MN\ 

RawSegmentShapefiles) 
c. Repair Geometry 
d. Add fields 

i. ATTRIBUTE (text 20) 
ii. COMMENTS (TEXT 255) 

iii. FIELD_VER (Text 1) 
e. Loads polygon shapefiles into File Geodatabase  

i. W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI_2010.gdb 
ii. MN_NWI feature dataset 

iii. Individual Feature Classes named named quadname_polys  (q3131ne_polys) 
f. Delete shapefiles from W:\GreatLakes_NWI_Update\MN\EcognitionOutput\polys once they have 

been backed up to external hard drive and added to file geodatabase. 
g. Copies feature classes from 

W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI_2010.gdb to 
\\GLARO_SDE\backup\Nwi_backup \MN\ActiveDatabase\MN_NWI_2010.gdb 
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4. Editor Tool - V:\Installs\GIS Misc\NWI\Object Inspector\Minnesota Object Inspector 
a. Interpreter can manually fill in the ATTRIBUTE field, or add codes to a list to select from the 

drop down. 
b. Joins quad with Random Forest .dbf (W:\GreatLakes_NWI_Update\MN\RandomForest\RF 

Results )based on COORID  
c. Only certain fields appear 

i. ATTRIBUTE  
ii. ACRES –  

iii. FIELD_VER 
iv. COMMENTS 
v. RFwetlnd – from random forest table 

vi. U– from random forest table 
vii. W– from random forest table 

viii. RFSubsys– from random forest table 
ix. RFSubcl– from random forest table 
x. Hydric WR_CLASS– from random forest table 

xi. Radar– from random forest table 

 
5. Before starting the 1st quad 

a. Use ArcCatalog to copy W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI_2010.gdb to 
local machine (D:\Working\NWI) 

b. Copy W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI.mxd to local machine 
(D:\Working\NWI) 

c. Install Object Inspector - Run Minnesota Object Inspector.msi under V:\Installs\GIS 
Misc\NWI\Object Inspector\Minnesota Object Inspector (install for everyone, not just me) 

d. Install MN NWI QA/QC toolbox:  V:\Installs\GIS Misc\NWI\QAQC Toolbox\MN_WI 
e. Load Find Multipart Polygon script to ArcMap button - V:\Installs\GIS 

Misc\ArcMap_Scripts_Tools\Find_Multipart_Polygons 
f. Map B:\GLARO_SDE\Backup\Nwi_Backup\MN\PostPhotoInterpSegments – select reconnect at 

logon 

 
6.  Pre-Photo Interpretation 

a. Using ArcCatalog, copy the quad for editing from 
W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI_2010.gdb and paste it into 
D:\Working\NWI \MN \MN_NWI_2010.gdb in the MN_NWI feature dataset 

b. Mark on map which quad you checked out.  This is very important to make sure two people are not 
working on the same quads. 

c. Still in Catalog, right-click on the MN_NWI feature dataset on your computer and go to New and 
then Topology 

i. The default name and cluster tolerance are fine 
ii. Select the newly added feature dataset 
iii. The default rank is fine 
iv. Click Add Rule 

a. Add Must Not Overlap 
b. Add Must Not Have Gaps 

v. Finish 
vi. Topology does not need to be validated at this time 
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7. The Map Document 

a. Add feature dataset to D:\Working\NWI \MN\ MN_NWI.mxd 
a. Or change the data source to save the symbology from a previous quad 

b. Image Boundary – the actual extent of the eCognition segmentation data for each quarter quad 
c. Reference grid – a simple polygon fishnet to help keep track of what has/has not been done 
d. Original NWI – this layer can be used for reference, but many of the codes are suspect. 
e. SSURGO Soils – another reference layer displayed by suggested water regime 
f. Topo – USGS 1:24k topographic map.   
g. Bing Maps – Aerial 
h. CIR_2010 – 2010 Raster\MN_1FT_2010 and/or MN_HALFMETER_2010 displayed 4,2,3) 
i. TrueColor_2010  Raster\MN_1FT_2010 and/or MN_HALFMETER_2010 displayed 1,2,3) 
j. 2009 NAIP 

a. A group of county level .sid images.  Can be expanded to turn different counties on/off or to 
move them up/down in drawing order 

k. MN_NAIP_2008 

 

8. Photo Interpretation 

a. Start editing nwi quad segment layer 
b. Open Attribute editor  
c. Merge/cut/classify polygons 

i. Make sure to look at all imagery and the topo 
ii. Check auxiliary data if unsure 
iii. Fill in attribute for all wetland polygons 
iv. If unsure, mark field verified field as “N”  
v. Leave comments if there are questions 
vi. We need to classify upland examples, but do not spent a lot of time on this step 
vii. Save edits often 
viii. Keep track of your progress on the map with graphics  
ix. Save the map document on occasion  
x. At least 1/day backup the feature dataset to W:\GreatLakes_NWI_Update\Data Backup 
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9. QA/QC own quarter quad 
a. When photo interpretation on a quad is complete, attribute and dissolve upland polygons. 

i. Select all unattributed polygons 
ii. Calculate ATTRIBUTE field with “U” 

iii. Select by attribute all “U” codes 
iv. Merge all “U” segments 
v. Select ALL segments and explode multipart features 

vi. Calculate acreage and visually check all polygons under .05 acres  
b. Run the MN NWI QAQC toolbox tools from ArcToolbox or the Command Prompt 

i. All Attributes must be valid 
ii. Double-check questionable attributes 

1. Usually mixed classes like AB/UB or EM/UB  
iii. No sliver polygons (under 0.01 acres) 

1. Merge these with neighboring polygon 
iv. No PUBs over 20 acres 

1. Open water over 20 acres should be a Lake (L1 or L2) 
c. Add the Topology (say no to adding layers involved in the topology since it Is already added) 

i. Start editing segment polygon layer 
ii. Run the validate topology for entire layer 

iii. Open the error inspector and search on all rules, for entire extent. 
iv. The Must Not have Gaps rule will flag all of the outside polygons – they are ok 

and can be ignored or marked as exceptions. 
v. All overlaps and gaps on the inside of the quad need to be corrected 

1. For gaps, use the create to make a new polygon 
i. Check to see if it should be merged with a neighbor 

2. For overlaps, use the merge to merge to the overlap to one of the 
neighboring polygons. 

3. Save edits 
d. Re-run the sliver test from the QA/QC toolbox 
e. Save edits/stop editing 
f. Copy with ArcCatalog into W:\GreatLakes_NWI_Update\ReadyforQAQC_MN_NWI_2010 
g. Copy quad segment layer into 

B:\GLARO_SDE\Backup\Nwi_Backup\MN\PostPhotoInterpSegements 
h. Fill out QAQC Status.xls on W:\GreatLakes_NWI_Update\Finished Geodatabases 

1. Quarter Quad Name (or number) 
2. State abbreviation 
3. Interpreter name 
4. Date in MM/DD/YYYY format that quad was completed 
5. Copied to backup – put Y to indicate the edited segment quad layer was 

copied from local hard drive to 
B:\GLARO_SDE\Backup\Nwi_Backup\MN\PostPhotoInterpSegements 

6. Save and close .xls 
i. Use ArcCatalog to delete segment quad feature class from D:\Working\NWI \MN 

\MN_NWI_2010.gdb\MN_NWI 
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10. QA/QC another interpreter’s quarter quad 
a.  Copy segment data from W:\GreatLakes_NWI_Update\ReadyforQAQC_MN_NWI_2010 to local 

machine. 
b. Perform visual inspection 
c. Rerun steps 9a through 9e 
d. Copy with ArcCatalog into W:\GreatLakes_NWI_Update\Finished_MN_NWI_2010 
e. Fill out QAQC Status.xls on W:\GreatLakes_NWI_Update\Finished Geodatabases 
f. Copy quad segment layer into 

B:\GLARO_SDE\Backup\Nwi_Backup\MN\PostPhotoInterpSegements rename with “postqaqc” at 
end. 
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11. Analyst QA/QC 
a. Fill out QAQC Status.xls on W:\GreatLakes_NWI_Update\Finished Geodatabases 
b. Copy and delete from W:\ GreatLakes_NWI_Update\MN\ Finished_MN_NWI_2010.gdb 
c. Check attributes and investigate any uncommon codes 
d. Perform visual inspection on quad 
e. Select all “U” codes and merge 

i. Select all unattributed polygons 
ii. Calculate ATTRIBUTE field with “U” 

iii. Select by attribute all “U” codes 
iv. Merge all “U” segments 
v. Select ALL segments and explode multipart features 

vi. Calculate acreage and visually check all polygons under .05 acres  
f. Run tool to check for adjacent features with the same attribute 
g. Validate and run topology (gaps and overlaps) and fix any errors 
h. Append classified segment data to Reference Data 

i. Select quad segments by attribute  
“ATTRIBUTE” <> “U” 

ii. Join selected table with W:\GreatLakes_NWI_Update\Codes\NWI_Code_LookupTable 
.dbf and export attributed records to .dbf 

a. FULL_CODE (All Valid codes) 
b. Class 
c. Subclass 
d. WATER_REG 
e. Modifier 
f. Wetland 

iii. Append exported .dbf to 
W:\GreatLakes_NWI_Update\MN\RandomForest\Reference_Data\Reference_Data.dbf 

i. Export all wetland segments to database to be sent to MNDNR for review 
j. Export all segments to B:\GLARO_SDE\Backup\Nwi_Backup\MN\Finished 
k. Append individual quarter quad segment feature class into seamless dataset for entire project 

area:  vector.glarogis. MN_NWI_2010 
l. Runs QA/QC tool box tools for MN 

i. All Attributes must be valid 
ii. No sliver polygons under 0.01 acres 

iii. No PUBs over 20 acres 
iv. No L1UBs under 20 acres 

m. Validate and run topology (gaps and overlaps) and fix any errors 
n. When complete 

i. Dissolve W:\GreatLakes_NWI_Update\MN\State_Level_NWI\ MN_State_NWI_2010.gdb 
1. Dissolve Field: ATTRIBUTE 
2. Uncheck Create multipart features 

ii. Convert result to coverage 
iii. Run GENERATE  <in cov> <out cov> 4 BendSimplify errorcheck 
iv. Delete uplands and non-attributed polygons 
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